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Programme Educational Objectives 
(PEO’s) of UG: 

 

 
PEO1 

Pursue higher education in the varied fields of mechanical 

engineering and management. 

PEO2 Secure a career placement in core and allied areas 

PEO3 Develop skills to undertake entrepreneurship and lifelong learning 

 

 

PROGRAMME SPECIFIC OUTCOMES 
(PSOs) of UG 

 

PSO1 Apply the knowledge of manufacturing, thermal and industrial 

engineering to formulate, analyze and provide solutions to the 

problems related to mechanical systems 

PSO2 Apply the design concepts and modern engineering software tools to 

model mechanical systems in various fields such as machine 

elements, thermal, manufacturing, industrial and inter-disciplinary 

fields.  
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DO’S 

➢ Wear uniform, shoes & safety glasses 

➢ Please follow instructions precisely as instructed by your supervisor. 

➢ If any part of the equipment fails while being used, report it immediately to your supervisor. 

➢ Students should come with thorough preparation for the experiment to be conducted. 

➢ Students will not be permitted to attend the laboratory unless they bring the practical 

record fully completed in all respects pertaining to the experiment conducted in the 

previous class. 

➢ All the calculations should be made in the observation book. Specimen calculations for 

one set of readings have to be shown in the practical record. 

➢ Wherever graphs are to be drawn, A-4 size graphs only should be used and the same 

should be firmly attached to the practical record. 

➢ Practical record should be neatly maintained. 

➢ Students should obtain the signature of the staff-in-charge in the observation book 

after completing each experiment. 

➢ Theory regarding each experiment should be written in the practical record before 

procedure in your own words. 

 
DONT’S 

➢ Do not touch hot work piece 

➢ Do not start the experiment unless your setup is verified & approved by your supervisor. 

➢ Do not leave the experiments unattended while in progress. 

➢ Do not crowd around the equipment’s & run inside the laboratory. 

➢ Don’t wear rings, watches, bracelets or other jewellery 

➢ Don’t wear neck ties or loose turn clothing of any kind. 

➢ Do not eat or drink inside labs. 

➢ Do not wander around the lab and distract other students 

➢ Do not use any machine that smokes, sparks, or appears defective 

 

 

SRI VENKATESWARA COLLEGE OF ENGINEERING & TECHNOLOGY 

[AUTONOMOUS] 

DEPARTMENT OF MECHANICAL ENGINEERING 



DEPARTMENT OF MECHANICAL ENGINEERING 
 

LIST OF EXPERIMENT 
 

 

 

 

 

 

Sr. Practical Name Page 

No. 

 

 
1. 

 

 

 
To Study of 3d Printing………………………………………….. 

No. 

 

 
09 

 
2. 

 
How to create a Simple Box………………………………………. 

 
12 

 
3. 

 
To Design a Basic Hex Nut………….…………………………..... 

 
14 

 
4. 

 
To Design a U Bracket Sheet Metal ………………….….……..... 

 
17 

 
5. 

 
To Design A Project Name Text………………………………….. 

 
23 

 
6. 
 

 

 
How to Print the design in 3D printer………………………...…... 

 
28 
 
 

          

        7.      To print the key chain in 3D printer………………………….........      39 
    

 

 

       8.     To print the simple box in 3D printer ………………………….....      53 
 

 

 

      9.      To print the Hex Nut in 3D printer ………………………….........      54 

 

 

 

      10.    To print the U Bracket in 3D printer ………………………….......     55 

 

 

 

 

 

 

 

 



DEPARTMENT OF MECHANICAL ENGINEERING 
 
 

 

S.No. 

 

 

NAME OF THE EXPERIMENT 

 

PAGE No. 

 

DATE OF 

EXP. 

 

FACULTY 

SIGNATURE 

1 

    

2 

    

3 

    

4 

    

5 

    

6 

    

7 

    

8 

    

9 

    

10 

    

11 

    

12 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



DEPARTMENT OF MECHANICAL ENGINEERING 
 
 

 

 

 

 

GENERAL INSTRUCTIONS 

1. Students should wear the uniform and closed foot wear. Students inappropriately dressed for lab, 

at the instructor’s discretion, are denied access.  

2. Eating and drinking are prohibited in the laboratory at all times. 

3. Never work in the laboratory without proper supervision by an instructor. 

4. Never carry out unauthorized experiments. Come to the laboratory prepared. If you are unsure 

about what to do, please ask the instructor. 

5. Except the scientific calculator, any other electronic devices are not permitted to use inside the 

Laboratory. 

6. Any damage to any of the equipment/instrument/machine caused due to carelessness, the cost will 

be fully recovered from the individual (or) group of students. 
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3D Printing  
 

 

 

Introduction 
 

3D printing or additive manufacturing is a process of making three dimensional solid objects from a 

digital file. 

The creation of a 3D printed object is achieved using additive processes. In an additive process an 

object is created by laying down successive layers of material until the object is created. Each of these 

layers can be seen as a thinly sliced cross-section of the object. 

3D printing is the opposite of subtractive manufacturing which is cutting out / hollowing out a piece of 

metal or plastic with for instance a milling machine. 

 

What is a 3D printer? 

 

3D printers are a new generation of machines that can make everyday things. They’re remarkable 

because they can produce different kinds of objects, in different materials, all from the same machine. 

A 3D printer can make pretty much anything from ceramic cups to plastic toys, metal machine parts, 

stoneware vases, fancy chocolate cakes or even (one day soon) human body parts. 

They replace traditional factory production lines with a single machine, just like home inkjet printers 

replaced bottles of ink, a printing press, hot metal type and a drying rack. 

 

Why is it called printing? 

 

If you look closely (with a microscope) at a page of text from your home printer, you’ll see the letters 

don’t just stain the paper; they’re actually sitting slightly on top of the surface of the page. 

In theory, if you printed over that same page a few thousand times, eventually the ink would build up 

enough layers on top of each other to create a solid 3D model of each letter. That idea of building a 

physical form out of tiny layers is how the first 3D printers worked. 
 

How do 3D printers work? 

 

You start by designing a 3D object on an ordinary home PC, connect it to a 3D printer, press ‘print’ 

and then sit back and watch. The process is a bit like making a loaf of sliced bread, but in reverse. 

Imagine baking each individual slice of bread and then gluing them together into a whole loaf (as 

opposed to making a whole loaf and then slicing it, like a baker does). That’s basically what a 3D 

printer does. 

The 3D printing process turns a whole object into thousands of tiny little slices, then makes it from the 

bottom-up, slice by slice. Those tiny layers stick together to form a solid object. Each layer can be 

very complex, meaning 3D printers can create moving parts like hinges and wheels as part of the same 

object. You could print a whole bike - handlebars, saddle, frame, wheels, brakes, pedals and chain - 

ready assembled, without using any tools. It’s just a question of leaving gaps in the right places. 

 

Applications of 3D printing. 

 

In recent years, 3D printing has developed significantly and can now perform crucial roles in many 

applications, with the most common applications being manufacturing, medicine, architecture, custom 

art and design, and can vary from fully functional to purely aesthetic applications. 

3D printing processes are finally catching up to their full potential, and are currently being used in 

manufacturing and medical industries, as well as by socio cultural sectors which facilitate 3D printing 

for commercial purposes. There has been a lot of hype in the last decade when referring to the 
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possibilities we can achieve by adopting 3D printing as one of the main manufacturing technologies. 

Utilizing this technology would replace traditional methods that can be costly and time consuming. 

There have been case studies outlining how the customization abilities of 3D printing through 

modifiable files have been beneficial for cost and time effectiveness in health care applications. 

There are different types of 3D printing such as Fused filament fabrication (FFF), Stereolithography 

(SLA), Selective Laser Sintering (SLS), polyjet printing, Multi-Jet Fusion (MJF), Direct Metal Laser 

Sintering (DMLS), and Electron Beam Melting (EMB). 

 

For a long time, the issue with 3D printing was that it has demanded very high entry costs, which does 

not allow profitable implementation to mass-manufacturers when compared to standard processes. 

However, recent market trends spotted have found that this is finally changing. As the market for 3D 

printing has shown some of the quickest growth within the manufacturing industry in recent years.[8] 

The applications of 3D printing are vast due to the ability to print complex pieces with a use of a wide 

range of materials. Materials can range from plastic and polymers as thermoplastic filaments, to 

resins, and even stem cells. 

 

Advantages of 3d printing process over conventional manufacturing process. 

 

1. Flexible Design 

3D printing allows for the design and print of more complex designs than traditional manufacturing 

processes. More traditional processes have design restrictions which no longer apply with the use of 

3D printing. 

 

2. Rapid Prototyping 

3D printing can manufacture parts within hours, which speeds up the prototyping process. This allows 

for each stage to complete faster. When compared to machining prototypes, 3D printing is inexpensive 

and quicker at creating parts as the part can be finished in hours, allowing for each design 

modification to be completed at a much more efficient rate. 

 

3. Print on Demand 

Print on demand is another advantage as it doesn’t need a lot of space to stock inventory, unlike 

traditional manufacturing processes. This saves space and costs as there is no need to print in bulk 

unless required. 

 

The 3D design files are all stored in a virtual library as they are printed using a 3D model as either a 

CAD, Solid Works or STL file, this means they can be located and printed when needed. Edits to 

designs can be made at very low costs by editing individual files without wastage of out of date 

inventory and investing in tools. 

 

4. Strong and Lightweight Parts selective-laser-melting-slm 

 

The main 3D printing material used is plastic, although some metals can also be used for 3D printing. 

However, plastics offer advantages as they are lighter than their metal equivalents. This is particularly 

important in industries such as automotive and aerospace where light-weighting is an issue and can 

deliver greater fuel efficiency. 

 

Also, parts can be created from tailored materials to provide specific properties such as heat 

resistance, higher strength or water repellency. 

 

5. Fast Design and Production 

Depending on a part’s design and complexity, 3D printing can print objects within hours, which is 
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much faster than molded or machined parts. It is not only the manufacture of the part that can offer 

time savings through 3D printing but also the design process can be very quick by creating STL or 

CAD, Solid Works files ready to be printed. 

 

What is Fused Deposition Modeling (FDM)? 

 

Fused deposition modeling is an additive manufacturing technology that creates 3D components using 

a continuous thermoplastic or composite material thread in filament form. An extruder feeds the 

plastic filament through an extruding nozzle, where it is melted and then selectively deposited layer by 

layer onto the build platform in a predetermined automated path. 

FDM, also known as Fused Filament Fabrication (FFF), is a Material extrusion technology, one of the 

seven main types of additive manufacturing technologies. FDM is the most widely used 3D printing 

technique, with the most 3D printer users globally, and is typically the first 3D printing technology to 

which people are exposed. 

Scott Crump pioneered the process in the 1980s under the registered term fused deposition modeling 

(FDM). Stratasys Inc, a business co-founded by Scott Crump, owns the trademark fused deposition 

modeling (FDM) and its abbreviation FDM. 

 

Stereolithography SLA 

 

Stereolithography is a 3D Printing process which uses a computer-controlled moving laser beam, pre-

programmed using CAM/CAD software. Stereolithography (SL) is an industrial 3D printing process 

used to create concept models, cosmetic - rapid prototypes, and complex parts with intricate 

geometries in as fast as 1 day. 

Stereolithography (SLA) is an industrial 3D printing process used to create concept models, cosmetic 

prototypes, and complex parts with intricate geometries in as fast as 1 day. A wide selection of 

materials, extremely high feature resolutions, and quality surface finishes are possible with SLA. 

SLA 3D printing is primarily used for: 

• parts requiring high accuracy and features as small as 0.07mm 

• good surface quality for cosmetic prototypes 

• form and fit testing.  

 

Selective laser melting. SLM 

 

Schematic of selective laser melting and the heat transfer in molten pool 

Selective laser melting (SLM) is one of many proprietary names. For a metal additive manufacturing 

(AM) technology that uses a bed of powder with a source of heat to create metal parts. Also known as 

direct metal laser sintering (DMLS), the ASTM standard term is powder bed fusion (PBF). PBF is a 

rapid prototyping, 3D printing, or additive manufacturing technique designed to use a high power-

density laser to melt and fuse metallic powders together. 

 
3D - Printing Materials: 

 

 

Filament shape and size. 

 

Actin filaments are the smallest type, with a diameter of only about 6 nm, and they are made of a 

protein called actin. Intermediate filaments, as their name suggests, are mid-sized, with a diameter of 

about 10 nm. Unlike actin filaments and microtubules, intermediate filaments are constructed from a 

number of different subunit proteins. 
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PLA material. 

 

Polylactic acid, also known as PLA, is a thermoplastic monomer derived from renewable, organic 

sources such as corn starch or sugar cane. Using biomass resources makes PLA production different 

from most plastics, which are produced using fossil fuels through the distillation and polymerization 

of petroleum. 

Despite the raw material differences, PLA can be produced using the same equipment as 

petrochemical plastics, making PLA manufacturing processes relatively cost efficient. PLA is the 

second most produced bioplastic (after thermoplastic starch) and has similar characteristics to 

polypropylene (PP), polyethylene (PE), or polystyrene (PS), as well as being biodegradeable. 

 

ABS material. 

ABS or Acrylonitrile butadiene styrene is a common thermoplastic polymer typically used for 

injection molding applications. This engineering plastic is popular due to its low production cost and 

the ease with which the material is machined by plastic manufacturers. Better yet, its natural benefits 

of affordability and machinability do not hinder the ABS material’s desired properties: 

Impact Resistance 

Structural Strength and Stiffness 

Chemical Resistance 

Excellent High and Low Temperature Performance 

Great Electrical Insulation Properties 

Easy to Paint and Glue 

ABS plastic attains these physical attributes through the initial creation process. By polymerizing 

styrene and acrylonitrile in the presence of polybutadiene, chemical “chains” attract each other and 

bind together to make ABS stronger. This combination of materials and plastics provides ABS with 

superior hardness, gloss, toughness and resistance properties, greater than that of pure polystyrene. 

View a detailed ABS Material Data Sheet to learn more about ABS’s physical, mechanical, electrical 

and thermal properties. 

 

PET Material. 

 

PET (also abbreviated PETE) is short for polyethylene terephthalate, the chemical name for polyester. 

PET is a clear, strong, and lightweight plastic that is widely used for packaging foods and beverages, 

especially convenience-sized soft drinks, juices and water. Virtually all single-serving and 2-liter 

bottles of carbonated soft drinks and water sold in the U.S. are made from PET. 

It is also popular for packaging salad dressings, peanut butter, cooking oils, mouthwash, shampoo, 

liquid hand soap, window cleaner, even tennis balls. Special grades of PET are used for carry-home 

food containers and prepared food trays that can be warmed in the oven or microwave. 

The basic building blocks of PET are ethylene glycol and terephthalic acid, which are combined to 

form a polymer chain. The resulting spaghetti-like strands of PET are extruded, quickly cooled, and 

cut into small pellets. The resin pellets are then heated to a molten liquid that can be easily extruded or 

molded into items of practically any shape. PET was first synthesized in North America in the mid-

1940s by DuPont chemists searching for new synthetic fibers. DuPont later branded its PET fiber as 

"Dacron." Today, more than half of the world's synthetic fiber is made from PET, which is called 

"polyester" when used for fiber or fabric applications. When used for containers and other purposes, it 

is called PET or PET resin. 
 

PETG material. 

 

PETG or Polyethylene terephthalate glycol is a thermoplastic polyester commonly used in 

manufacturing. The PET component is what is commonly found in plastic beverage bottles and food 

products. The G stands for glycol, which adds durability and strength, and contributes to the 
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compound's impact resistance and ability to withstand high temperatures. Despite the seemingly PLA-

dominated market, the PETG filament is quickly becoming a popular choice among 3D printing 

aficionados for several reasons 
 

Polycarbonate material. 

 

Polycarbonates (PC) are a group of thermoplastic polymers containing carbonate groups in their 

chemical structures. Polycarbonates used in engineering are strong, tough materials, and some grades 

are optically transparent. They are easily worked, molded, and thermoformed. Because of these 

properties, polycarbonates find many applications. Polycarbonates do not have a unique resin 

identification code (RIC) and are identified as "Other", 7 on the RIC list. Products made from 

polycarbonate can contain the precursor monomer bisphenol A (BPA). 

 

Nylon material. 

 

Nylon is a generic designation for a family of synthetic polymers composed of polyamides (repeating 

units linked by amide links). Nylon is a silk-like[3] thermoplastic, generally made from petroleum, 

that can be melt-processed into fibers, films, or shapes .  2  Nylon polymers can be mixed with a wide 

variety of additives to achieve many different property variations. Nylon polymers have found 

significant commercial applications in fabric and fibers (apparel, flooring and rubber reinforcement), 

in shapes (molded parts for cars, electrical equipment, etc.), and in films (mostly for food packaging). 

Nylon was the first commercially successful synthetic thermoplastic polymer. DuPont began its 

research project in 1927. The first example of nylon, (nylon 66), was synthesized using diamines on 

February 28, 1935, by Wallace Hume Carothers at DuPont's research facility at the DuPont 

Experimental Station. In response to Carothers' work, Paul Schlack at IG Farben developed nylon 6, a 

different molecule based on caprolactam, on January 29, 1938. 10 

 

Nylon was first used commercially in a nylon-bristled toothbrush in 1938 followed more famously in 

women's stockings or "nylons" which were shown at the 1939 New York World's Fair and first sold 

commercially in 1940, whereupon they became an instant commercial success with 64 million pairs 

sold during their first year on the market. During World War II, almost all nylon production was 

diverted to the military for use in parachutes and parachute cord. Wartime uses of nylon and other 

plastics greatly increased the market for the new materials. 

 

3D-printer feature for printer selection : 

Filament Diameter. 

 

 There are many types of filament available with different properties, requiring different temperatures 

to print. Filament is commonly available in the two standard diameters of 1.75 mm and 2.85 mm.[2] 

2.85 mm filament is sometimes erroneously referred to as "3 mm", but should not be confused with 

the less common filament size that actually measures 3 mm in diameter. 

 

Nozzle Diameter. 

The standard bore diameter for an FDM 3D printer nozzle is 0.4 mm. However, nozzles can be 

swapped out for those of a different size; small-diameter nozzles are useful for fine details on the X-Y 

plane, while large-diameter nozzles can deposit more material at once, leading to faster printing. 

 

Hotend. 

The hotend can be described as the component of an FDM 3D printer that heats, melts and extrudes 

the material layer by layer through a nozzle. The whole structure of the hotend helps to maintain a 

consistent and accurate temperature as well as providing an optimized thermal dissipation. 
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Number of Exturders/ Hotend . 

The 3D printer extruder is a series of parts that handle the moving and processing of plastic filament. 

 

Some people think of the “extruder” as being exclusively the motor and associated parts that push and 

pull the filament. Others, the entire assembly including the hot end – where the melting and deposition 

of the filament takes place. 

 

To keep things simple, we’re considering the entire assembly as the extruder. Explaining the extruder 

requires a close look at two crucial assemblies, commonly referenced to as the “cold end” and the “hot 

end”. 

 

Heated Bed. 

A heat bed is an additional module for a 3D printer that makes the cooling process of 3D-printed 

materials more controlled, for better results. Heat beds prevent issues like poor adhesion to the print 

bed, poor adhesion between layers, thermal runaway and warping. 

 

Printer volume.  

Print volume refers to the number of prints or copies an organization produces regularly, and it's 

typically measured in monthly increments, also known as prints per month. When shopping for a new 

copier or printer, one of the most important factors you need to consider is your current print volume. 

 

Type of bed levelling. 

A level build plate should result in a consistent first layer. Visually, it will look like nicely “squished” 

lines all the way through. Often, it’s pretty obvious that something’s off with the first layer, and 

sometimes, that’s the result of an unlevel print bed.Here are a few common signs of an unlevel bed: 

 

The filament doesn’t stick to the build surface in certain areas. 

Filament does not leave the nozzle in some places. 

The filament’s height and width varies across the build surface. 

The gaps between lines of filament vary across the build surface. 
 

Parts cooling.  

 

Cooling is one of the most important aspects of printing with PLA. Having a dedicated part cooling 

fan makes a huge difference in the quality of the printed parts. The freshly extruded plastic needs to 

cool down below the glass transition temperature as quickly as possible. 

 

Bed material 

 The key to a successful 3D print is a good first layer, and the key to a successful first layer is 

choosing the right print bed surface for the material you are 3D printing. In this guide, we will go 

through the most popular 3D materials to print with and describe the best techniques for getting them 

to stick to the bed and achieving a stellar first layer. 

 

BuildTak and FlexPlate 

BuildTak is a popular all purpose 3D bed surface. It comes as a sheet with an adhesive back. Simply 

peel the protective film off and then stick it to your bed.  

 

In addition, the FlexPlate System makes utilizing BuildTak sheets even easier. Available in many 

sizes to fit all kinds of 3D Printers, simply add the Magnetic Base on top of the existing print bed and 

the FlexPlate with attached BuildTak sheet will magnetically connect. After a 3D Print is finished the 

top two sheets easily slide away from the print bed and with a twist the part releases cleanly. Replace 

the FlexPlate and BuildTak sheet to the magnetic base and you're ready to print your next part! 
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Motion Kinematic used 

 

3D Printers with Different Kinematics: Comparison, Advantages and Disadvantages 

 

There are various 3D printing technologies: Digital Light Processing (DLP), stereolithography (SLA), 

Selective Laser Sintering (SLS), Selective Heat Sintering (SHS) and the others. In this article we are 

going to explain the FFF technology and talk about its advantages and disadvantages as well as 3D-

printers that use it. 

 

Introduction 

FFF printers (Fused Filament Fabrication) are also known as FDM printers (Fused Deposition 

Modelling). These devices are able to create prints by depositing molten plastic on the print bed layer-

by-layer. FFF printers are used both for commercial purposes and at home. 

. 

Kinematics in 3D printing 

Each 3D printer uses its own kinematics that controls the movement of the mechanical parts: print 

beds and extruders. In this article we will review four types of FDM-printers: Cartesian, Delta, Polar 

and 3D printers with robotic arms. 

 
 

Cartesian printers are the most common FFF/FDM printers on the market. The technology uses three 

axes – X, Y, Z (Cartesian coordinate system) to determine the movements of mechanical parts: the 

print head and the bed move according to the coordinates. 

 

There is a limited number of possible ways for platforms and print heads to move: 

 

The platform moves horizontally along one of the axes — X or Y, the extruder moves vertically along 

the other axis . 

The platform moves horizontally (Z), the extruder moves two-dimensionally in along the X-Y axes. 

The platform moves vertically and along one of the horizontal axes, the extruder moves horizontally. 

The platform doesn’t move, the extruder moves three-dimensionally. 

The platform moves along the XY axes, the extruder moves vertically. 

 

Filament Drive type (Extruder type) 

There are three main material extrusion addi- tive manufacturing technologies used to print scaffolds 

for tissue engineering as shown in Fig. 2: (1) filament-fed extruders, (2) screw extruders (typically fed 

by melted polymer pellets), and (3) syringe extruders (typically filled with a hydrogel or polymer 

pellets). 
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Control software and hardware type (open and closed source) 

Open-source hardware and software allow your machine to keep on 3D printing regardless of what 

happens to the manufacturer and its support. In theory, any broken part can be reproduced once the 

complete design is open to everyone, or further enhanced by leveraging the community’s problem-

solving abilities. 

 

There are various open-source tools within the 3D printing world, including different types of 

software (e.g. printer firmware, slicer programs, 3D modeling software), hardware, and 3D printable 

files that can be found on community-sourced websites like Thingiverse, Cults, and MyMiniFactory. 

 

Filament runout sensor 

This filament runout sensor is designed for detect whether your filament is run out during the printing 

process. The sensor will send the signal to the printer when the filament is run out and printer will 

pause the print job until the new filament is loaded when the printer w/ correct firmware and setting. 

 

Interaction interface (AKA screens) 

A touch sensitive screen displays the information on the screen and also receives the input by sensing 

a user's touch on the same screen. This mechanism facilitates system interaction directly through the 

screen without needing a mouse or keyboard. This method has the advantage to make the system 

compact by removing keyboard, mouse and similar interactive device. However there are certain 

difficulties to implement a touch screen interface. 

Options to transfer files 

 Select IPro > Print > 3D Print Preview. 

 Select Options and choose desired resolution and click OK. 

 Within the preview window, select Save Copy As or Send to 3D Print Service. 

 Save As type to STL File (*.stl) 

 

Controller board type 

 Lerdge-Z. 

 Smoothie board v1. 

 SKR Mini E3. 

 SKR 2.0. 

 SKR Pro 1.2. 

 Duet 2 Wifi. 

 MKS SBASE V1.3. 

 

Sketcher in Solid Works 
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EXPERIMENT -1 

To Study of 3D Printing 

Introduction:-3Dprinting allows for rapid prototyping and on site manufacturing of 

products. Initially done with plastic, 3D printing now uses new techniques with new 

materials, such as aluminum, bronze, and glass. Biomaterials are also being incorporated, 

such as 3D printing gear cartilage and liver tissue. As the 3D printing industry grows, 3D 

printing will become a big part of many engineering fields. 

Flow layout of Pre 3D Printing 
 

Components of 3D Printer: - 

1. Axes 

Fixed Rods, The three axes that the 3D printer utilizes are on the Cartesian coordinate 

system. The linear fixed rods are maintained at right angles to each other and each 

represents a coordinate axis. 

Movement, The timing belts and pulleys allow the movement of the hot end (or the 

print bed, depending on the type of 3D printer) along each axes according to the g-

code (generated by slicing software). The stepper motors power this movement. 

2. Extruder 

Extrusion is the feeding of filament into the hot end of the 3D printer. This movement 

is also powered by a stepper motor. 

Retraction, This mechanism is the pulling of the melted filament from the hot end. 

This movement is primarily programmed through the g-code to prevent the formation 

of unwanted filament creating a bridge between two areas. The bridging of unwanted 

filament is referred to as stringing or the formation of cobwebs. 

Dual Extrusion some models of 3D printers are equipped with dual extrusion 

capabilities.Thisallowsformixedmaterialobjectstobeprinted.Dualextrusioncanbe 
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used to print out complex objects with a different colour material as the support, 

making it easy to differentiate between the object and the support. 

3. Hot End 

The hot end is heated to temperatures ranging from 160 C to 250 C, depending on the 

type of filament to be used. The hot end melts the filament and pushes the melted 

filamentthroughthenozzle.Thehotendneedstobethermallyinsulatedfromtheother 

components of the 3D printer to prevent any damage. 

4. Print Bed 

Heated Print beds that are heated improve print quality of 3D printed objects. The 

heatedbedisheatedtotheglasstransitiontemperatureofthefilamentbeingused.This allows 

the model layers to slightly melt and stick to the heated bed. 

Non-Heated Print beds that are not heated require adhesion in the form of glue, tape, 

hairspray, etc. In the innovation lab, painters tape is frequently used for adhesion. 

5. Filament 

Filament is a consumable used by the 3D printer to print layers. Filament comes in a 

variety of materials and colors. Filament can be composed of metal, wood, clay, 

biomaterials, carbon fiber, etc. 

i). ABS:-ABSisathermoplasticthatneedstobeheatedtotemperaturesfrom210Cto 250C. 

ABS can only be printed on a 3D printer with a heated bed, which prevents the 

cracking of the object. When ABS is heated, it emits a strong unpleasant odor. ABS 

requires a complete enclosure while printing. 

ii). PLA: - PLA is a thermoplastic that needs to be heated to temperatures from 160C 

to220C.PLAisalsobiodegradableandemitsslightodors.PLAismostfrequentlyused in the 

Innovation Lab on all 3Dprinters. 

 

PVA PVA is a water soluble plastic that is frequently used for support in dual extrusion 3D 

printers. The printed object is left in water where the PVA support is dissolved and the 

finished object printed in the other filament remains. 

Preparing your 3D Model in SOLID WORKS Software: - 

SOLID WORKS software is used to create 3D models and designs. This software is available 

on our computers and the level of difficulty varies. With the exception of Sketch up Pro and 

the industry standard software mentioned, all of these programs are available on the 

innovation lab computers. 

Solid works main idea is user to create drawing directly in 3D or solid form. From this solid 

user can assemble it directly on their workstation checking clashes and functionality of it. 

Creating drawing is pretty easy just drag and drop the solid to drawing block. 

Preparing your 3D Model for print in Idea maker software:- 

These are following step for 3D printing of model 

1. Install the 3D print software idea maker 

2. Check repair option in this software 

3. Set the nozzle parameter and build tack temperature according to the printer guide. 
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Step:-1 Prepare the design Model using Designing Software(Solids Works, Auto cad etc.) 

Step:-2 Convert the designed Model file in Stl , obj format. 

Step:-3 Prepare the design model for printing Using Software Idea Maker and Ultimaker. 

Then set all parameter (nozzle temp., buildtak temp and support) and also repair your design 

using software option. Then after generate the file in Gcode format 

Step:-4 ON the 3D Printer and load the filament in nozzle and give the command print by 

using 3D Printing Machine. 

Precaution of 3D Printer machine: - 

These are some following precaution when you print the design in 3D Printer 

1. Mechanical: Do not place limbs inside the build area while the nozzle is in motion. 

The printer nozzle moves in order to create the object. 

2. High Temperature: Do not touch the printer nozzle – it is heated to a high temperature 

in order to melt the build material. 

3. Always buy replacement parts from the manufacturer for safety related equipment 

4. Choose an area that has adequate ventilation and exhaust capability 

Safety Equipment: - 

• Safety Glasses 

• Gloves (recommended for post processing) 

Application of 3D Printer: - 
 

• Automotive 

• Marine 

• Aerospace 

Advantages: - 

• Medical 

• Engineering 

• Architecture 

 

• Complex shapes 

• Freedom for design 

• Customize parts 

• Less waste 

• Fewer unsold products 

• Less transport 
 

Limitations: - 

• Time 

• Cost 

• Skill 

• Materials 
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EXPERIMENT -2 

How to create simple box 

 

In this First exercise we will design a simple Box as seen in the figure below. This exercise 

will build the foundations of how to design 3D parts in Solid Works and introduce several 

fundamental features such as Sketching, Dimensioning and Extruding and printing on rise 3d 

machine. Let’s begin. Check all Electrical connections. 

 
Step1. First we install 3d design software in your computer like Solid work auto cad, etc. 

Step2. Open the solids work software and click New option in software window 

1. Click New , Option 

2. Click Part and OK . 

3. Click on Top Plane and click Sketch. 
 

 

 

 

 

 

4. Click Rectangle origin. 

 

 

 

5. Click Smart Dimension , click side edge and click top edge to 

dimension it as 1.0in x1.0in. 
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6. Click Features>Extruded Boss/Base 

 

 
set D1 as 1.0in 

 

 
and click . 

 
7. It’s done. Simple Right? 
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EXPERIMENT -3 

To Design A Basic Helix Shape 

In this Second exercise we will design a simple hexagonal unthreaded nut as seen in the 

figure below. This exercise will build the foundations of how to design 3D parts in Solid 

Works and introduce several fundamental features such as Sketching, Dimensioning and 

Extruding and printing on rise 3d machine. Let’s begin. Check all Electrical connections. 

Step1. First, start a new part by going to New > 

Part > Ok. Since we have already set up Solid 

Works to use MMGS as default units, all our units 

should be in millimeters, grams and seconds. You 

should now be greeted with the main drafting 

interface of Solid Works. 

Step2. On the left-hand side, you will see the Feature 

Manager Design Tree. Right click on “Top Plane” and 

click the “Normal To” option. Now we are facing the 

Top Plane head-on. 

Step 3. While the Top Plane is selected, switch to the 

Sketch tab at the top of the interface and select the 

“Sketch” tool in the top left corner. We are now 

creating a sketch on the Top Plane. Anything we 

sketch will appear on the Top Plane. First, we want to 

sketch the basic hexagonal outline of the nut. 

i. Click the “Polygon” tool in the Sketch tab. A list 

of parameters should appear in the left-hand panel. 

ii. Set the number of sides to 6 (hex = 6). Other 

parameters such as center position, angle, etc. are 

also modifiable, but we will not adjust these. 

iii. Next, over the origin (the base of the two red 

arrows) until the cursor snaps onto the dot in the 

middle. Left click once to start the sketch. 

iv. Left click again at some point to the right of the 

first point. Press enter to finalize the sketch. 
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v. Now, select the “Circle” tool in the Sketch tab and sketch a circle starting at the 

origin, similar to how we sketched the hexagon. Press enter to confirm the circle 

sketch. 

 

4. Now we will assign dimensions to our outline. Make sure we are still in sketch mode 

by looking at the top left corner and seeing that the Sketch button is depressed and 

now reads “Exit Sketch”. Press the “S” key on the keyboard. In the small window, 

click the “Smart Dimension” tool. 

 

Now let’s set the center-to-edge dimensions of the hexagon, 

i. Left click the center 

ii. Then left click the top side (be sure to select as ide edge and not one of the points 

between two edges). 

iii. A dimension measurement should pop up. Left click again anywhere on the screen and a 

small window will appear. Enter 10mm into this field and hit enter. The hexagon is now 

assigned a dimension of 10mm (center to edge). Double click the dimension label to 

change the assigned dimension at any time. Follow the same procedure to set the 

diameter of the circle to 10mm. Select Exit Sketch when finished. The sketch should now 

appear as follows: 
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5. Now that our sketch is assigned dimensions and finalized, we are ready to bring this 

shape into the 3rd dimension. Select our sketch by clicking “Sketch1” in the left 

panel. The sketch should turn light blue as it is selected. Next, switch to the 

Features tab at the top and click the “Extruded Boss/Base” tool. Immediately you 

should see the shape gain depth. Using the parameters on the left panel, give the nut 

a depth of 7.5mm. Hit enter to confirm the extrusion. The shape should now appear 

as follows: 
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EXPERIMENT -4 

How to create U bracket Sheetmetal 
 

 

In this exercise, we will design a U Bracket Sheet metal as seen in the figure below. This 

exercise will build the foundations of how to design 3D parts in Solid Works and introduce 

several fundamental features such as Sketching, Dimensioning and Extruding and printing on 

rise 3d machine. Let’s begin. Check all Electrical connections. 

These are following step for making of U bracket sheet metal. 

1. Click New. Click Part, OK. 

2. Click Front Plane and click on Sketch. 

 

Use Line ,Sketch U shape. Dimension sketch with Smart Dimension as1in x 

1.5in x1in and 1.5inheight. 

3. Click Offset Entities andclickUsketch.Setoffsetdistanceas0.1in,check 

Reverse box and OK. 
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4. Use Line , sketch and connected open end of this sketch and make it close both 

end. 

 

 

 

 
 

5. Click Features>Extruded Boss/Base setD1 to 1in and OK. 

6. Click View>Bottom 

 

 
click on bottom face and click Sketch. 
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7. Click Circle and sketch 2 circle on bottom face each side. Use Smart Dimension 

to dimension this sketch as sketched below. 

 

 

 

 

 

 

 

 
 

8. Click 
 

 

 

 

 

 

 

 

9. Click View>Isometric. 

 
 

 

 

 

10. Click Fillet , check box Full round fillet. 
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11. Click side left side face as Side Face1. 

 
12. Click on pink box and click right side face as Side Face Set2 and OK. 

 

 
13. Repeat step 11 – 13 for the other side. 
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14. Repeat step 11 – 13 for inner face and outer face of U bracket. 
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15.  Click Sheet metal>Insert Bends, click flat face as reference when it flatten. Set 

bend radius to 0.03in and K factor 0.5 and OK. 

 

 

16. Your simple Sheet metal bend is ready. Look at part tree. 
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EXPERIMENT -5 

To Create a Project Name 
 

 

In this exercise, we will design a create a project name as seen in the figure below. This 

exercise will build the foundations of how to design 3D parts in Solid Works and introduce 

several fundamental features such as Sketching, Dimensioning and Extruding and printing on 

rise 3d machine. Let’s begin. Check all Electrical connections. 

These are following step for making of Project Name. 

Step1:-Open the new file in solid works software and select the part option as shown in 

below figure 
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Step 2: - select the any on plane (top ,front, right) for making of design then select the text 

option and write the test as show in below figure. 
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Step 3.: - after design of text select the font option and design the text size, height, width as 

per parameter of design and then after select the features menu extruded option and increase 

the height of text in 3d view as per parameter of design. 
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Step 3.: - select the instant 3d option for showing the view of 3d design. after that save, the 

file in stl. File format. 
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EXPERIMENT -6 

How to Print the design in 3D printer 

This exercise will build the foundations of how to Print the design in 3D Printer. Let’s begin. 

Check all Electrical connections. These are following steps before start the printing. 

Step 1.:- first we install the software related the 3D printer(idea maker, ultimaker etc.)In idea 

maker first open the software and click the open file option as shown in below figure. 
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Step 2.:- Select the Pan option and select the extruder (left of right) for printing the design 

and then after select the Repair option for auto correction of design of software parameter as 

shown in below figure. 
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Step 3.:- Select the Move option for design print portion in build tack plate and then after 

select the Rotate option for rotate the design easily printed and used low print material as 

shown in below figure. 
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Step 3.:- select the Scale option for design scale according to build tack plate area and then 

after click the start option and select printing option standard as shown in below figure. 
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Step 4.:- After complete the all setting then click the Slice option and export the file in G code 

format. 
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Step 5.:- After generate the G code format then follow the these instruction as shown in below 

figure. 

◼ Switch on the 3dprinter. 
 

◼ Place your Pen drive in USB. 
 

◼ Clean your surface bedplate. 
 

◼ Load your filament into the required extruder as per the requirement. 
 

◼ Wait until the nozzle & bed plate comes into the required temperature. 
 

◼ Close the doors of 3dprinter. 
 

◼ Open the file from the USB storage and select the Print option. 
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EXPERIMENT -7 

How to Print the college name in 3D 

printer 
 

Designing the  Keychain 

1. The first step to designing the keychain is to draw the base shape: 

a. Start 2D Sketch. (Figure 2) 

 

Figure 2: Sketch Mode 

b. Select the XZ plane. (Figure 3) 

 

Figure 3: XZ Plane 

c. Rotate the camera to orient the top correctly using the arrows in the top right of the 

screen. 

d. Select the rectangle tool from the "Sketch" section of the toolbar. (Figure 4) 

https://manual.eg.poly.edu/index.php/File:Lab_1B2.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B3.jpg
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Figure 4: Rocking Rectangle 

i. Draw a 2.6” x 0.7” rectangle starting at the origin. 

ii. These values can be typed in (switching which value is changed is done using the tab 

key) 

e. Select the circle tool. 

i. Draw a 0.7” diameter circle centered in the middle of one of the short sides of the 

rectangle (the cursor should snap to the center position and becomes blue X with a 

triangle when you get close.) (Figure 5) 

 

Figure 5: Cool Circle 

ii. Draw another circle 0.45” in diameter in the same position, the sketch should look like 

Figure 6. 

https://manual.eg.poly.edu/index.php/File:Lab_1B4.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B5.jpg


Page|41 

DEPARTMENT OF MECHANICAL ENGINEERING 
 

 

 

Figure 6: Smaller Circle 

f. Fillet (round) sharp edges. 

i. Select the fillet tool from the “Sketch” section of the toolbar (do not use the one under 

"Modify"). (Figure 7) 

 

Figure 7: THE Fillet Tool 

ii. Select one of the two intersecting lines that form the right angles on the base. 

iii. Use the default fillet size of 0.125” and repeat on the other corner. 

iv. The sketch should look like Figure 8. 

https://manual.eg.poly.edu/index.php/File:Lab_1B6.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B7.jpg


Page|42 

DEPARTMENT OF MECHANICAL ENGINEERING 
 

 

 

Figure 8: Fillet Everything 

g. Remove the extra lines using the trim tool 

i. Select the trim tool from the “Sketch” section of the toolbar (It is under the fillet tool). 

ii. Select all interior lines that divide the keychain. 

iii. If error messages are indicated, remove the dimensions on the rest of the keychain. 

iv. The sketch should look like Figure 9. 

 

Figure 9: Keychain base 

h. Exit the sketch using the "Stop Sketch" button. 

2. After creating a 2D sketch, the next step is to use that to create a 3D object. In this lab the 

extrude tool will be used to create a 3D block. In the future, the revolve or other tools can be 

used to create more advanced geometry. 

a. Select the “Extrude” tool from the “Create” section of the toolbar (Figure 10). 

https://manual.eg.poly.edu/index.php/File:Lab_1B8.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B9.jpg
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Figure 10: Extrude Tool 

i. Select the profile of the object to be extruded, which is the object that was just created. 

ii. Change the extrusion thickness to 0.15” and press Enter. 

iii. The model will look like Figure 11. 

 

Figure 11: #Deep 

3. The next step is to add the design to the key chain. For this lab, a vector graphics file will be 

used in the dxf format provided by NYU. In the future, a logo can be designed using the 

sketch tool. 

a. Download the NYU Tandon Vector Logo (This logo was converted from the file 

provided on NYU's identity page). 

i. * Tandon logo ACAD format 

b. Select “Insert DXF" under the "Insert" section of the toolbar. (Figure 12) 

https://manual.eg.poly.edu/images/6/60/Tandon_long_white.zip
https://manual.eg.poly.edu/index.php/File:Lab_1B10.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B11.jpg
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Figure 12: Insert DXF 

c. Select the top surface of the key chain (Figure 13). 

 

Figure 13: Top Surface Select 

d. Rotate the camera again to orient the top correctly. 

e. Click on the file folder on the window that pops up and select .dxf file you 

downloaded. 

f. The logo should appear. (Figure 14) 

 

https://manual.eg.poly.edu/index.php/File:Lab_1B12.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B13.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B14.jpg
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Figure 14: Beautiful Logo 

i. Make sure you change the units to inches. 

ii. Delete this portion with the “Delete” key on the keyboard (Not Backspace). 

 

g. The logo needs to be scaled to fit the key chain. To keep the spacing of the design, 

select an appropriate base point. Use the midpoint of the line on the right side of the 

box. 

i. Select the point tool under the "Sketch" section of the toolbar. 

ii. Place a point at the center point of the right side of the box. 

iii. Delete the bottom and the left side of the box. (Figure 15) 

 

Figure 15: Partly Delete Box 

iv. Select the "Scale tool from the "Modify" section of the toolbar. 

v. Select the box and torch of the logo by clicking and dragging. 

vi. Select the midpoint that was just placed as the base point for scaling 

vii. Enter a scaling factor of 0.75. (Figure 16) 

 

Figure 16: Scale the Box 

https://manual.eg.poly.edu/index.php/File:Lab_1B16.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B17.jpg
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viii. Redraw the 2 sides of the box we deleted using the line tool in the “Sketch” section of 

the toolbar. (Figure 17) 

 

Figure 17: Redraw Box 

h. The logo will be positioned on the keychain. 

i. Select the entire logo and use the “Move” tool from the Modify section of the toolbar 

to move it off the base so there is space to draw the alignment line. 

 

Figure 18: Adjust the Logo 

ii. Select the line tool and draw a 0.925” line from the center of the circle towards the 

center of the keychain. 

iii. Select the logo using the move tool again. 

iv. Select “Point to Point” as the move type in the window that appears. (Figure 19) 

https://manual.eg.poly.edu/index.php/File:Lab_1B18.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B19.jpg
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Figure 19: Move the Logo 

v. Select the midpoint from the side of the box and the end of the line you just created. 

1. The logo should snap to it. (Figure 20) 

 

Figure 20: Snap the Logo 

vi. Delete the guideline you created. 

vii. Exit the sketch. 

viii. The final sketch is shown in Figure 21. 

https://manual.eg.poly.edu/index.php/File:Lab_1B20.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B21.jpg
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Figure 21: Finally Final Sketch 

4. To finish this side of the keychain, the design must be cut into the base. To do this, the extrude 

tool will be used. 

a.  

i. To cut the design, select “Extrude" from the "Create" section of the toolbar. 

ii. Select the profile of the design to cut, in this case, the area around the torch and each 

of the letters. (Figure 22) 

 

Figure 22: Select the Outline 

iii. Select "Cut" from the drop down menu next to "Operation" in the window that 

appeared on the right. (Figure 23) 

https://manual.eg.poly.edu/index.php/File:Lab_1B22.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B23.jpg
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Figure 23: Cut the Outline 

iv. Select a distance of -0.06". 

v. The final model is shown in Figure 24. 

 

Figure 24: Depth to the Outline 

5. To 3D print the design, export the file as an STL. This is the only format that can be opened by 

the 3d printing software. 

a. Click on triangle to the left "Document Settings" to expand the menu, and hover over 

"Units" to click on the "Change Active Units" button on the right to change to 

millimeters, but DO NOT set millimeters as the default (default units should be 

inches). This will convert the model into millimeters. Even though the models are built 

in inches, millimeters is the only unit that 3D printing software will recognize. 

b. Right click on the box above “Document Settings” and select “Save as STL”. (Figure 

25) 

https://manual.eg.poly.edu/index.php/File:Lab_1B24.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B25.jpg
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Figure 25: Save Your Work 

c. Click "OK" no need to change any of the setting. 

d. Make sure you save it to a location you'll remember like the desktop. 

6. The last step of the keychain is to make the white insert that will fit in the center to make it two 

colors. 

a. Click “File" in the toolbar at the top of the screen. 

b. Start a "New Design". (Figure 26) 

 

Figure 26: New Design 

c. Create a rectangle with dimensions 2.2”x0.65”. 

d. Extrude the rectangle 0.12”. 

i. This model is shown in Figure 27. 

https://manual.eg.poly.edu/index.php/File:Lab_1B26.jpg
https://manual.eg.poly.edu/index.php/File:Lab_1B27.jpg
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Figure 27: Inside Box 

e. Save this the same way as before. 

Preparing to print 

1. Now that the logo design is complete, the next step is to put it together in the 3D printing slicer 

software. We will be using Cura as the software for orienting parts on the printer and selecting 

the color of each object. It also generates toolpaths that the printer will follow to print the 

objects. 

a. Open Cura. If a menu pops up prompting for the printer, select the “Ultimaker 3” 

i. If a menu does not pop up, make sure the printer currently selected is “Ultimaker 3” on 

the top right corner 

ii. Otherwise, click the arrow, select the “Add Printer” option, and add “Ultimaker 3.” 

b. To load your two files from above, select “Open File” on the top left corner and open 

the STL file containing the base of the keychain 

c. Using the “Rotate” tool on among the options to the left, rotate the part so the torch is 

facing up 

i. Uncheck the “Snap Scaling” option to allow for a more precise rotation 

d. Select “Open File” again and load the filler rectangle 

e. Again, orient the part correctly using the “Rotate” tool 

f. Cura, by default, drops the objects on to the build-plate and keeps objects apart. The 

following steps are needed to combine the filler rectangle within the keychain: 

i. Under “Preferences”, select “Configure Cura” 

ii. Under “Viewport behavior,” make sure to deselect both “Ensure models are kept 

apart” and “Automatically drop models to the build plate” if they are not already 

deselected 

iii. Save your preferences 

iv. Return to the buildplate and make sure both objects are lying flat on the build-plate by 

using “Rotate” => “Lay Flat” 

https://manual.eg.poly.edu/index.php/File:Lab_1B28.jpg
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1. If the “Lay Flat” tool does not lay the object flat, manually type in 0 mm in the 

“Move” tool for the Z axis 

g. Select the filler rectangle, and using the “Move” tool on the left, enter 0.15mm as the Z 

value to raise it vertically 

h. Select one object and choose a different extruder on the left. That piece will appear as a 

different color 

i. Drag the filler piece and place it in the keychain base part 

j. Save the file as a .gcode and upload it to the website 

s 

 

Step 1: Create or Find a Design. 

Step 2: Export the STL File. 

Step 3: Choose Your Materials. 

Step 4: Choose Your Parameters. 

Step 5: Create the Gcode. 

Step 6: Print. 
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EXPERIMENT -8 

How to Print the Simple box in 3D printer 

Preparing to print 

1. Now that the part design (simple box) is complete, the next step is to put it together in the 3D 

printing slicer software. We will be using Cura as the software for orienting parts on the printer 

and selecting the color of each object. It also generates tool paths that the printer will follow to 

print the objects. 

a. Open Cura. If a menu pops up prompting for the printer, select the “Ultimaker 3” 

i. If a menu does not pop up, make sure the printer currently selected is “Ultimaker 3” on 

the top right corner 

ii. Otherwise, click the arrow, select the “Add Printer” option, and add “Ultimaker 3.” 

b. To load your two files from above, select “Open File” on the top left corner and open 

the STL file containing the base of the keychain 

i. Using the “Rotate” tool on among the options to the left, rotate the part so the torch is 

facing up Uncheck the “Snap Scaling” option to allow for a more precise rotation 

c. Select “Open File” again and load the filler rectangle 

d. Again, orient the part correctly using the “Rotate” tool 

e. Cura, by default, drops the objects on to the build-plate and keeps objects apart. The 

following steps are needed to combine the filler rectangle within the keychain: 

i. Under “Preferences”, select “Configure Cura” 

ii. Under “Viewport behavior,” make sure to deselect both “Ensure models are kept 

apart” and “Automatically drop models to the build plate” if they are not already 

deselected 

iii. Save your preferences 

iv. Return to the buildplate and make sure both objects are lying flat on the build-plate by 

using “Rotate” => “Lay Flat” 

1. If the “Lay Flat” tool does not lay the object flat, manually type in 0 mm in the 

“Move” tool for the Z axis 

f. Select the filler rectangle, and using the “Move” tool on the left, enter 0.15mm as the Z 

value to raise it vertically 

g. Select one object and choose a different extruder on the left. That piece will appear as a 

different color 

h. Drag the filler piece and place it in the keychain base part 

i. Save the file as a .gcode and upload it to the website 

 

Step 1: Create or Find a Design. 

Step 2: Export the STL File. 

Step 3: Choose Your Materials. 

Step 4: Choose Your Parameters. 

Step 5: Create the Gcode. 

Step 6: Print. 
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EXPERIMENT -9 

How to Print the Hex Nut in 3D printer 

Preparing to print 

1. Now that the part design (Hex Nut) is complete, the next step is to put it together in the 3D 

printing slicer software. We will be using Cura as the software for orienting parts on the printer 

and selecting the color of each object. It also generates tool paths that the printer will follow to 

print the objects. 

a. Open Cura. If a menu pops up prompting for the printer, select the “Ultimaker 3” 

i. If a menu does not pop up, make sure the printer currently selected is “Ultimaker 3” on 

the top right corner 

ii. Otherwise, click the arrow, select the “Add Printer” option, and add “Ultimaker 3.” 

b. To load your two files from above, select “Open File” on the top left corner and open 

the STL file containing the base of the keychain 

i. Using the “Rotate” tool on among the options to the left, rotate the part so the torch is 

facing up Un check the “Snap Scaling” option to allow for a more precise rotation 

c. Select “Open File” again and load the filler rectangle 

d. Again, orient the part correctly using the “Rotate” tool 

e. Cura, by default, drops the objects on to the build-plate and keeps objects apart. The 

following steps are needed to combine the filler rectangle within the keychain: 

i. Under “Preferences”, select “Configure Cura” 

ii. Under “Viewport behavior,” make sure to deselect both “Ensure models are kept 

apart” and “Automatically drop models to the build plate” if they are not already 

deselected 

iii. Save your preferences 

iv. Return to the buildplate and make sure both objects are lying flat on the build-plate by 

using “Rotate” => “Lay Flat” 

1. If the “Lay Flat” tool does not lay the object flat, manually type in 0 mm in the 

“Move” tool for the Z axis 

f. Select the filler rectangle, and using the “Move” tool on the left, enter 0.15mm as the Z 

value to raise it vertically 

g. Select one object and choose a different extruder on the left. That piece will appear as a 

different color 

h. Drag the filler piece and place it in the keychain base part 

i. Save the file as a .gcode and upload it to the website 

 

Step 1: Create or Find a Design. 

Step 2: Export the STL File. 

Step 3: Choose Your Materials. 

Step 4: Choose Your Parameters. 

Step 5: Create the Gcode. 

Step 6: Print. 
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EXPERIMENT -10 

How to Print the U bracket in 3D printer 

Preparing to print 

1. Now that the part design (U bracket) is complete, the next step is to put it together in the 3D 

printing slicer software. We will be using Cura as the software for orienting parts on the printer 

and selecting the color of each object. It also generates tool paths that the printer will follow to 

print the objects. 

a. Open Cura. If a menu pops up prompting for the printer, select the “Ultimaker 3” 

i. If a menu does not pop up, make sure the printer currently selected is “Ultimaker 3” on 

the top right corner 

ii. Otherwise, click the arrow, select the “Add Printer” option, and add “Ultimaker 3.” 

b. To load your two files from above, select “Open File” on the top left corner and open 

the STL file containing the base of the keychain 

i. Using the “Rotate” tool on among the options to the left, rotate the part so the torch is 

facing up Uncheck the “Snap Scaling” option to allow for a more precise rotation 

c. Select “Open File” again and load the filler rectangle 

d. Again, orient the part correctly using the “Rotate” tool 

e. Cura, by default, drops the objects on to the build-plate and keeps objects apart. The 

following steps are needed to combine the filler rectangle within the keychain: 

i. Under “Preferences”, select “Configure Cura” 

ii. Under “Viewport behavior,” make sure to deselect both “Ensure models are kept 

apart” and “Automatically drop models to the build plate” if they are not already 

deselected 

iii. Save your preferences 

iv. Return to the build plate and make sure both objects are lying flat on the build-plate by 

using “Rotate” => “Lay Flat” 

1. If the “Lay Flat” tool does not lay the object flat, manually type in 0 mm in the 

“Move” tool for the Z axis 

f. Select the filler rectangle, and using the “Move” tool on the left, enter 0.15mm as the Z 

value to raise it vertically 

g. Select one object and choose a different extruder on the left. That piece will appear as a 

different color 

h. Drag the filler piece and place it in the keychain base part 

i. Save the file as a .gcode and upload it to the website 

 

Step 1: Create or Find a Design. 

Step 2: Export the STL File. 

Step 3: Choose Your Materials. 

Step 4: Choose Your Parameters. 

Step 5: Create the Gcode. 

Step 6: Print. 


